
Оршил буюу асуудлыг сөхөхүй Эрэл хайгуул Суулгах ба тохируулах TEX системийг хэрэглэх Асуулт хариулт

TEX системийн хэрэглээ

Г.Махгал

МУИС-МКС

2011 оны 11 сарын 25

Г.Махгал МУИС-МКС

TEX системийн хэрэглээ



Оршил буюу асуудлыг сөхөхүй Эрэл хайгуул Суулгах ба тохируулах TEX системийг хэрэглэх Асуулт хариулт

Удиртгал

TEX системийн талаарх товч ойлголтыг өгнө

Одоогоор бидний хэрэглэж байгаа TEX тархац ба редакторын
талаар, тодруулбал үүсдэг хүндрэл, тулгарч буй бэрхшээл
зэргийг авч үзнэ

Хангалттай сайн хөгжсөний дээр эрчимтэй хөгжсөөр байгаа TEX
тархац ба редакторуудыг авч үзнэ

Хэрэглэхэд тохиромжтой тархац ба редакторыг олж сонгоно

Дээр сонгосон тархац ба редакторыг суулгах тохируулахтай
холбогдох зааврыг өгнө

TEX хэрэглээтэй холбогдох зарим нэг, тодруулбал, үзүүлэн
бэлдэх ба математикийн томъёог веб хуудсанд байрлуулахтай
танилцуулж зөвлөгөө өгнө
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1 Оршил буюу асуудлыг сөхөхүй
TEX системийн тухай
TEX Монголд нэвтэрсэн нь
TEX системийн хэрэглээнд гардаг хүндрэл ба тулгарч буй
бэрхшээлүүд

2 Эрэл хайгуул
Хэрэгцээ шаардлага
Харьцуулалт ба сонголт

3 Суулгах ба тохируулах
TEX тархацыг суулгах
Редактор суулгах ба тохируулах

4 TEX системийг хэрэглэх
Монгол хэл ба үсгийн кодчлол
TEX ашиглан үзүүлэн бэлдэх
TEX форматаар шивсэн томъёог веб хуудсанд байрлуулах

5 Асуулт хариулт
Г.Махгал МУИС-МКС
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TEX системийн тухай

TEX гэж юу вэ?

Хэвлэлийн эх бэлтгэх систем
Ном, сэтгүүл, илтгэл, өгүүлэл, үзүүлэн, захидал зэргийн
эхийг өндөр чанартайгаар бэлдэх
Олон улсад /de-facto/ стандартчлагдсан
Үйлдлийн систем, програм хангамжаас үл хамаарах
Тогтвортой, найдвартай
1978 оноос хойш өнөөг хүртэл
Бидний онцлох давуу тал
Математикийн томъёог хамгийн хялбар шивэх бас
чанартайгаар хэвлэх. Зохиогч Donald Knuth нь ч
математикч
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TEX системийн тухай

TEX системээр эх бэлтгэхэд шаардагдах зүйлс

1 Тархац
2 Редактор
3 DVI ба PDF үзүүлэгч
4 Зургийн програм

Г.Махгал МУИС-МКС

TEX системийн хэрэглээ



Оршил буюу асуудлыг сөхөхүй Эрэл хайгуул Суулгах ба тохируулах TEX системийг хэрэглэх Асуулт хариулт

TEX системийн тухай

Тархацууд

Тархац∗

Харьцуулалт TEX Live MikTEX
Үйдлийн систем Windows, Mac, Linux Windows, Linux (beta)
Лиценз GPLv2 Free
Хөгжүүлэлт Идэвхтэй Идэвхтэй
Сүүлийн хувилбар 2011 (2011-07-05) 2.9 (2010-10-09)
Суулгацын хэмжээ 2.3 GB 1.1 GB

∗ - хамгийн өргөн тархсаны дээр одоогоор эрчимтэй
хөгжүүлэгдэж байгаа тархацууд
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TEX системийн тухай

Редакторууд

Харьцуулалт
Редактор Юникод дэмжлэг Үйлдлийн систем Лиценз

WinEdt × Win Төлбөртэй
TeXmaker X Win, Mac, Linux GPL
LyX X Win, Mac, Linux Үнэгүй
LEd × Win Үнэгүй
TeXnicCenter X Win GPL
Eclipse X Win, Mac, Linux EPL
Gedit X Linux GPL
Kile X Linux (Win, Mac) GPL
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TEX Монголд нэвтэрсэн нь

Монголд TEX нэвтэрсэн нь

Монголын хувьд TEXийн “загалмайлсан эцэг” бол
А.Мекей /академич, МУ-ын гавъяат багш, профессор/ юм
90-ээд оны сүүлээр TEX дээр эх нь бэлтгэгдсэн анхны
номууд хэвлэгдсэн
TEXийн монгол хэлний багцууд

MonTeX
2000 онд Oliver Corff, Доржпаламын Дорж нар зохиосон.
Кирилл ба Монгол бичиг багтсанаас гадна Дөрвөлжин ба
Соёмбо үсгийн багцуудыг зохиосон байдаг
Mongolian Babel
2007 оноос
Хөгжүүлэгч нь Доржготовын Батмөнх
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TEX системийн хэрэглээнд гардаг хүндрэл ба тулгарч буй бэрхшээлүүд

Бидний хэрэглэж байгаа WinEdt редакторын талаар

Давуу тал
1 Шууд ба урвуу хайлттай
2 Алдааны шинжилгээ сайтай
3 Томъёо ба тэмдэгт цэснээс оруулах боломжтой
4 Хэрэглэгчийн ажлын орчин аятай, сонголт ба

тохируулгын өргөн боломжтой
Сул тал

1 Юникод дэмждэггүй
2 Лиценз зөвшөөрөлгүйгээр, өөрөөр хэлбэл, хууль

бусаар хэрэглэж байгаа /Hard Wisdom нэрийн дор/
3 Windows-өөс өөр үйлдлийн системд ажилладаггүй
4 Эх код нь хаалттай
5 Автомат гүйцээлтгүй
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TEX системийн хэрэглээнд гардаг хүндрэл ба тулгарч буй бэрхшээлүүд

Unicode хэмээхийн учир

Үсэг тэмдэгт нь дискэнд хадгалахад, өөрөөр хэлбэл физик
төвшинд bit(0 эсвэл 1)-үүдийн хослолоор илэрхийлэгддэг.
1B буюу 8 bit-ээр 28 = 256 тэмдэгтийг кодлох боломжтой
“а” үсэг cp-1251 кодоор 8 bit UTF-8 юникодоор 16 bit
Нэг тэмдэгт 1 Byte байхын давуу тал
Мэдээллийг хадгалах, зөөх, дамжуулахад хялбар
Нэг тэмдэгт 1 Byte байхын дутагдал
Латинаас өөр үсгийг кодлоход бэрхшээлтэй,
шинэ тэмдэгтийг “багтааж шингээх” газаргүй
Юникод үүсэх нөхцөл шаардлага
Орчин үед 8 битийн давуу талууд үнэ цэнээ алдсаны дээр
мэдээллийн технологийн хөгжил нь олон улс үндэстнүүдийн
цагаан толгойг нэгдсэн стандартаар кодлоход хүргэсэн

Г.Махгал МУИС-МКС

TEX системийн хэрэглээ



Оршил буюу асуудлыг сөхөхүй Эрэл хайгуул Суулгах ба тохируулах TEX системийг хэрэглэх Асуулт хариулт

TEX системийн хэрэглээнд гардаг хүндрэл ба тулгарч буй бэрхшээлүүд

Бидний хэрэглэж байгаа MikTEX v2.3 тархацын талаар

Давуу тал
Давуу тал гэх зүйл байхгүй
Сул тал

1 Хоцрогдсон /одоогийн хувилбар нь 2.9/
2 Монгол хэлний MonTex багц дахь үсгийн

тодорхойлолт нь алдаатай
3 Windows-өөс өөр үйлдлийн системд ажилладаггүй
4 Шинэ хувилбаруудаасаа мэдэгдэхүйц удаан хөрвүүлдэг
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Хэрэгцээ шаардлага

TEX тархац ба редакторын эрэл хайгуулын шалтгаан ба
тавигдах шаардлага

1 Юникод дэмждэг байх
2 Монгол хэлний багцын үсгийн тодорхойлолт алдаагүй

байх
3 Windows төдийгүй Linux тархацуудад ажилладаг байх
4 Хэрэглэгчийн орчин нь боловсронгуй байх
5 Шивэхэд хялбар байх /автомат гүйцээлт, хүснэгт зэрэг

нийлмэл кодыг оруулах нэмэлт цонх/
6 Алдааны задлан шинжилгээ сайтай байх, шууд ба урвуу

хайлттай байх
7 MikTEX 2.3 ба WinEdt ашиглан нэгэнтээ бэлдсэн эхийг

боловсруулахад асуудалгүй байх, өөрөөр хэлбэл, cp-1251
кодтой эхийг таньдаг байх
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Харьцуулалт ба сонголт

TEX тархац

TEX тархацын харьцуулалт ба сонголт

Тархац
Харьцуулалт TEX Live MikTEX

Үйдлийн систем Win, Mac, Linux∗ Win∗, Linux (beta)
Хэлний багц Mongolian babel Mongolian babel

∗ - санал болгох сонголт, энд интернэтийн сүлжээнээс
татаж авах, суулгах ба тохируулахад хялбар байхыг нь
чухалчилсан.
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Харьцуулалт ба сонголт

Mongolian babel багц

MonTEX шиг үсгийн тодорхойлолтын алдаагүй
TEX Live ба MikTEX аль алинд нь дэмжигддэг
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Харьцуулалт ба сонголт

Өргөнөөр хэрэглэгддэг редакторууд дээрх үндсэн
харьцуулалт

Үндсэн харьцуулалт
Редактор Юникод дэмжлэг Үйлдлийн систем Лиценз

WinEdt × Win Төлбөртэй
TeXmaker∗ X Win, Mac, Linux GPL
TeXnicCenter × Win GPL
LEd × Win Үнэгүй
LyX∗ X Win, Mac, Linux Үнэгүй
BaKoMa TeX X Win, Mac, Linux Төлбөртэй
Kile∗ X Linux, Win, Mac GPL

∗ - үргэлжлүүлэн харьцуулах редакторууд
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Харьцуулалт ба сонголт

Редакторуудын нэмэлт харьцуулалт №1

Нэмэлт харьцуулалт
Редактор Шивэх горим Алдааны боловсруулалт Урвуу хайлт
TeXmaker код × X
LyX WYSIWYW - X
Kile код X X
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Харьцуулалт ба сонголт

Редакторуудын нэмэлт харьцуулалт №2

Нэмэлт харьцуулалт
Редактор Автомат гүйцээлт Нийлмэл код оруулах

Код Үг харилцах цонх
TeXmaker X × X
LyX X X X
Kile X X X
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Харьцуулалт ба сонголт

Редакторуудын нэмэлт харьцуулалт №3 - TeXMaker
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Харьцуулалт ба сонголт

Редакторуудын нэмэлт харьцуулалт №3 - LyX

Г.Махгал МУИС-МКС

TEX системийн хэрэглээ



Оршил буюу асуудлыг сөхөхүй Эрэл хайгуул Суулгах ба тохируулах TEX системийг хэрэглэх Асуулт хариулт

Харьцуулалт ба сонголт

Редакторуудын нэмэлт харьцуулалт №3 - Kile
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Суулгах тархац ба редакторууд

Windows үйлдлийн системийн хувьд
MikTEX тархац
TeXmaker
LyX
Kile

Linux /Ubuntu/ үйлдлийн системийн хувьд
TEX Live
Kile
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TEX тархацыг суулгах

MikTEX тархацыг интернэтээс татаж авах

1 miktex.org сайтаас “MiKTeX Net Installer”-ийг татаж авна
2 MikTEXийг татаж авах

1 “MiKTeX Net Installer” програмыг ажиллуулна
2 Харилцах цонхны “Task” алхмаас “Download MikTeX”-ийг

сонгоно
3 “Basic” эсвэл “Complete” хувилбарын алинаар татаж авахаа

сонгоно
4 “Download Source”-ийг сонгоно
5 Татцыг хадгалах хавтсаа заана
6 “Start” дарсанаар татаж эхэлнэ
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TEX тархацыг суулгах

MikTEX тархацыг суулгах

1 MikTEXийн setup програмыг дуудаж ажиллуулна
2 Basic эсвэл Complete хувилбарын алинаар суулгахаа

сонгоно
3 Ямар хэрэглэгчдийн хувьд суулгахаа заана
4 Суулгах хавтсаа заана
5 Байнга ашиглах цаасны хэмжээ болон setup-ийн багцуудын

бүрдэл дутуу үед хэрхэхийг заана
6 Суулгах ажиллагааг эхлүүлнэ
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TEX тархацыг суулгах

TEX Live тархацыг суулгах

1 Терминалаас

sudo apt−get i n s t a l l t e x l i v e − f u l l

командыг өгнө
2 Дараа нь

sudo texha sh
sudo fm t u t i l−s y s −−a l l

командуудыг өгнө
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TEX тархацыг суулгах

TEX Live тархац дээр монгол хэлний багцыг нэмж суулгах

1 Терминалаас

sudo apt−get i n s t a l l t e x l i v e
t e x l i v e −l ang−mongol ian t e x l i v e −l ang− c y r i l l i c

командыг өгнө /дээрх командуудыг мөр шилжилгүй бичнэ/
2 Дараа нь

sudo texha sh

ба

sudo fm t u t i l−s y s −−a l l

командуудыг өгнө
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Оршил буюу асуудлыг сөхөхүй Эрэл хайгуул Суулгах ба тохируулах TEX системийг хэрэглэх Асуулт хариулт

TEX тархацыг суулгах

TEX Live дэх монгол хэлний багцын үгийг үеэр таслах
алдааг засах

1 Терминалаас

sudo g e d i t / va r / l i b / texmf / t e x / g e n e r i c /
c o n f i g / l anguage . dat

командыг өгнө /дээрх командуудыг мөр шилжилгүй бичнэ/
2 mongolian хайлтаар олдох мөрүүдийг өөрчилнө:

mongo l ian loadhyph−mn−c y r l−x−2a . t e x
mongo l ian2a loadhyph−mn−c y r l . t e x

3 Эцэст нь

sudo texha sh
sudo fm t u t i l−s y s −−a l l
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Оршил буюу асуудлыг сөхөхүй Эрэл хайгуул Суулгах ба тохируулах TEX системийг хэрэглэх Асуулт хариулт

Редактор суулгах ба тохируулах

TeXmaker редакторыг Windows дээр суулгах

1 xm1math.net/texmaker хаягаар орж татаж авна
2 Татаж авсан Setup програмаа ажиллуулан суулгана

Г.Махгал МУИС-МКС
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Редактор суулгах ба тохируулах

TeXmaker редакторыг Yap DVI үзүүлэгчтэй холбох

Yap DVI үзүүлэгчийн source link-ийн үүсгүүрийг
идэвхжүүлэх

1 Цэснээс “Options->Configure Texmaker” командыг өгнө
2 Нээгдэх цонхны “Commands” хэсгийн “LaTeX” талбарыг

дараах байдлаар өөрчилнө

l a t e x −−s r c − i n t e r a c t i o n=nonstopmode %. t e x %0 "%N%T"

Yap ба TeXMaker хоорондын урвуу хайлтыг тохируулах
1 Yap-ийн цэснээс “View->Options” командыг өгнө
2 Нээгдэх цонхны “Inverse DVI Search” хавтан дахь New

товчийг дарна
3 TeXMaker-ийн замыг зааж улмаар command line-ийг

"%f " "% l "

гэж заагаад ямар нэгэн нэрээр хадгална
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Редактор суулгах ба тохируулах

LyX редакторыг Windows дээр суулгах

1 lyx.org сайтаас Windows үйлдлийн системд зориулсан
хувилбарыг татаж аван ажиллуулна

2 Setup-ийн бүрэн бүтэн байдал ба системийн шаардлагыг
шалгана

3 Лицензийн шаардлагыг зөвшөөрсөнөө баталгаажуулна
4 Редакторыг ямар хэрэглэгчдийн хувьд суулгахаа заана
5 LATEX тархацаа дараах байдлаар заана

C: \ Program F i l e s \MikTeX 2 .9\ miktex \ b i n

6 Редакторыг суулгах хавтсаа заана
7 Редакторыг суулгах
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Редактор суулгах ба тохируулах

Kile редакторыг Ubuntu Linux дээр суулгах

Терминалаас

sudo apt−get i n s t a l l k i l e

командыг өгнө.
Хэрэв өмнө нь TEX Live суугаагүй байсан бол basic
байдлаар дагаж сууна
Шинэ хувилбарыг нь launchpad.net сайтаас авч суулгах
боломжтой
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Редактор суулгах ба тохируулах

Ubuntu Linux дээр Kile ба Okular /DVI үзүүлэгч/
хоорондын урвуу хайлтыг тохируулах

Хэрэв Okular суугаагүй бол дараах командаар суулгана

sudo apt−get i n s t a l l o k u l a r

Kile програмын хувьд
1 Цэс: “Settings/Configure Kile...”
2 Цонх: “Tools->Build” гээд жагсаалтаас “LaTeX”-ийг сонгоно
3 Сонголт: “Configuration” дахь “Default” сонголтыг “Modern”

гэж солино.
Okular програмын хувьд

1 Цэс: “Settings/Configure Okular...”
2 Цонх: ”Editor“ гээд жагсаалтаас ”Kile“-ийг сонгоод Ok
3 Багажит мөр: ”Browse“ горимыг сонгоно.

Ашиглалт: ”Shift+Click“
Г.Махгал МУИС-МКС
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Редактор суулгах ба тохируулах

Kile редакторыг Windows дээр суулгах №1

1 windows.kde.org сайтаас Windows үйлдлийн системд
зориулсан KDE-г татаж авна

2 Татаж авсан програмаа ажиллуулж “Install from
Internet”-ийг сонгоод Next товчийг дарна

3 Суулгах хавтсаа заана
4 “Install mode” ба “Compiler mode”-ийг сонгоно. Онц

шаардлагагүй бол сонголтыг өөрчлөлгүй үргэлжлүүлнэ
5 KDE-ийг татаж авах хавтсаа заана
6 Интернэтэд хэрхэн холбогдохыг заана. Онц шаардлагагүй

бол сонголтыг өөрчлөлгүй үргэлжлүүлнэ
7 KDE-ийг татаж авах серверээ сонгоно
8 Татаж авах KDE-ийн хувилбараа сонгоно
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Редактор суулгах ба тохируулах

Kile редакторыг Windows дээр суулгах №2

9 KDE багцуудын жагсаалтаас “Kile” ба “Kate”-ийг сонгоно.
Хэрэгтэй гэж үзвэл “Spelling Packages“ дундаас монгол хэл
ба бусад хэлний багцуудыг сонгоно

10 Kile болон сонгогдсон бусад багцуудыг дагалдаж суух
багцуудын мэдээлэл гарна

11 Багцуудыг татагдаж эхлэх ба улмаар автоматаар сууна
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Редактор суулгах ба тохируулах

Windows дээр Kile ба Okular /DVI үзүүлэгч/ хоорондын
урвуу хайлтыг тохируулах

Kile програмын хувьд
1 Цэс: ”Settings/Configure Kile...“
2 Цонх: ”Tools->Build“ гээд жагсаалтаас LaTeX-ийг сонгоно
3 Сонголт: ”Configuration“ дахь “Default” сонголтыг “Modern”

гэж солино.
Okular програмын хувьд

1 Цэс: “Settings/Configure Okular...“
2 Цонх: ”Editor“ гээд жагсаалтаас ”Kile“-ийг сонгоод Ok
3 Багажит мөр: ”Browse“ горимыг сонгоно.

Ашиглалт: ”Shift+Click“
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Оршил буюу асуудлыг сөхөхүй Эрэл хайгуул Суулгах ба тохируулах TEX системийг хэрэглэх Асуулт хариулт

Редактор суулгах ба тохируулах

Kile редакторын үсгийн кодчлолыг тохируулах

1 Цэс: ”Settings/Configure Kile...“
2 Цонх: ”Editor->Open/Save“ гэж сонгоно
3 Сонголт: ”General“ хавтан дахь

1 “Encoding” сонголтыг “Unicode (UTF8)”
2 “Fallback Encoding” сонголтыг “Cyrillic (cp 1251)”

болгож өөрчилнө
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Монгол хэл ба үсгийн кодчлол

Монгол хэлний багцыг ашиглах

Толгой файлдаа

\ usepackage [ mongo l ian ] { babe l }

гэж зарлана. Жишээлбэл:

\ documentc l a s s [ a4 paper , 11 pt , two s i d e ] { r e p o r t }
\ usepackage [ mongo l ian ] { babe l }
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Монгол хэл ба үсгийн кодчлол

Үсгийн кодчлолыг заах

Толгой файлдаа
юникодоор шивсэн бол

\ usepackage [ u t f 8 ]{ i npu t en c }

cp-1251 кодоор, өөрөөр хэлбэл, монгол гарын драйвер
ашиглан шивсэн бол

\ usepackage [mn]{ i npu t en c }

гэж зарлана. Жишээлбэл:

\ documentc l a s s [ a4 paper , 11 pt , two s i d e ] { r e p o r t }
\ usepackage [ u t f 8 ]{ i npu t en c }
\ usepackage [ mongo l ian ] { babe l }
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TEX ашиглан үзүүлэн бэлдэх

TEX ашиглан үзүүлэн бэлдэх

Documentclass зарлах хэсэг өөрчлөгдөнө

\ documentc l a s s {beamer}

Загварыг тодорхойлох хэсэг нэмэгдэнэ

\ProvidesPackageRCS $Header : /home/vedranm/ b i t b u c k e t /beamer/ base / themes /theme/ beamer themeBer l i n . s ty , v d02a7 c f 4d8ae 2010/06/17 09 : 11 : 41 r i v a n v x $
\Dec lareOpt ionBeamer { compress }{\ beamer@compresst rue }
\ProcessOpt ionsBeamer
\mode<p r e s e n t a t i o n >
. . .

Слайд буюу хуудас таслалтыг зохиогч өөрөө удирдана
Алдааны боловсруулалт учир дутагдалтай
Томъёоны үзэмж муу
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TEX ашиглан үзүүлэн бэлдэх

Слайд оруулах жишээ

\ frame
{\ f r am e t i t l e { T i t l e }
\ beg i n { i t em i z e }
\ item $a^2+b^2=c^2$
\ item $ s i n ^2x+cos^2x=1$

\end{ i t em i z e }
}

a2 + b2 = c2

sin2x + cos2x = 1
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TEX ашиглан үзүүлэн бэлдэх

Beamer класс ба түүний загваруудын талаар

Beamer класс ба үндсэн загварууд нь TEX тархацыг
дагалддаг
Загварууд

Интернэтээс бэлэн загвар татаж суулган ашиглах
боломжтой
Үндсэн загварууд, тэдгээрийн хувилбаруудын харьцуулсан
жагсаалт http://www.hartwork.org/beamer-theme-matrix/
хаягаар интернэтэд байрладаг

Класс, загварууд ба жишээ зэргийн талаар илүү ихийг
https://bitbucket.org/rivanvx/beamer/wiki/Home хаягаар
орж сонирхох боломжтой
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TEX ашиглан үзүүлэн бэлдэх

Beamer ашиглан TEX дээр үзүүлэн бэлдэхийн давуу тал

1 TEXийн томъёо боловсруулах хүч чадлыг эзэмшинэ
2 Слайдын загвар дизайн, формат жигд, үзэмжтэй болно
3 Үзүүлэн бэлдэхэд тавигдах шаардлагуудыг өөрийн

мэдэлгүйгээр дагаж эхлэх болно
4 Үзүүлэнгээ PDF форматаар бэлдэх тул цааш хуулбарлагдан

ашиглагдахаас тодорхой хэмжээнд “сэргийлж” чадна
5 Үзүүлэнгээ түгээхэд хялбар болно
6 Эх нь TEX форматаар байх тул цааш ашиглахад хялбар

байна
7 Томъёо цаашилбал нарийн бус бүтэцтэй хүснэгт, зургийг

оруулахад маш хялбар болно
8 Хөдөлмөр, цаг хугацаа хэмнэгдэнэ
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TEX форматаар шивсэн томъёог веб хуудсанд байрлуулах

TEX форматаар шивсэн томъёог веб хуудсанд байрлуулах

Сервер дээрээ TEX суулгаж ашиглах

Програм суулгах тул
Dedicated сервер
Хувийн сервер

байх шаардлагатай

Гадны серверийн TEXийг ашиглах
Жишээлбэл codecogs.com

1√
2π

∫ x

0

e−x2/2dx

Standalone (гадаад) editor
Integrated (дотоод) editor буюу Editor-ийн нэмэлт плагин
(FCK Editor, CK Editor, . . . )
CMS-ийн нэмэлт плагин (Wordpress, Joomla, phpBB, . . . )

Г.Махгал МУИС-МКС

TEX системийн хэрэглээ

http://www.codecogs.com/


Оршил буюу асуудлыг сөхөхүй Эрэл хайгуул Суулгах ба тохируулах TEX системийг хэрэглэх Асуулт хариулт

TEX форматаар шивсэн томъёог веб хуудсанд байрлуулах

Standalone editor ашиглах

http://www.codecogs.com/latex/eqneditor.php
Нээгдэх цонхонд томъёогоо TEX форматаар шивнэ

\ f r a c {1}{\ sqr t {2\ pi }}\ i n t_{0}^{x}e^{−x^2/2}dx

Үр дүн HTML форматаар

<img
src=" ht tp :// l a t e x . codecogs . com/ g i f . l a t e x ?

\ f r a c {1}{\ s q r t {2\ p i }}\ int_ {0}^{x}e^{−x^2/2}dx"
t i t l e="\ f r a c {1}{\ s q r t {2\ p i }}

\ int_ {0}^{x}e^{−x^2/2}dx"
/>
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TEX форматаар шивсэн томъёог веб хуудсанд байрлуулах

Integrated editor ашиглах

Ажиллах зарчмын хувьд Standalone editor-той адилхан
боловч код (HTML) хуулж байрлуулахыг
хөнгөвчилсөнөөрөө ялгаатай
Editor суулгах зэргээр веб технологийн мэдлэг шаардагдана
Томъёо оруулах

FCK Editor, CK Editor, . . . зэрэг editor дээрх томъёоны дүрс
бүхий товчийг дарахад Standalone editor нээгдэнэ
Томъёогоо шивж дуусгаад “Copy to Document” товчийг
дарна
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TEX форматаар шивсэн томъёог веб хуудсанд байрлуулах

codecogs.com-ыг CMS-тэй холбох

Холбох зарчим нь өмнөхтэй адил
CMS-ийн контентийн агуулгатай ажиллах тодруулбал,
тусгайлсан tag-аар
(жишээлбэл <tex>a^2+b^2=c^2</tex>)
хашигдсан TEX кодыг CodeCogs-ын серверт нийцэх формат
руу хувиргах нэмэлтийг зохион бичиж, суулгана. Өргөн
дэлгэрсэн CMS-үүдийн хувьд тийм нэмэлт бэлэн байдаг
Контент дахь TEX томъёогоо tag-аараа хашиж бичнэ
Томъёонууд веб хөтөч дээр очихдоо зургийн tag-руу
хөрвүүлэгдсэн байх ба тухайн зургуудыг codecogs.com-ын
серверээс дуудаж ачаалдаг
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TEX форматаар шивсэн томъёог веб хуудсанд байрлуулах

codecogs.com серверийн талаар

Томъёоны чанар маш сайн
Серверийн хурд хангалттай өндөр
TEX форматыг (зарим нарийн нийлмэл кодыг эс тооцвол)
шууд танина
Үйлчилгээний үнэ: Үнэгүй ба Төлбөрт

Хязгаарлалт:
{

өдөрт 3000 томъёо, үнэгүй
төлбөрөөс хамаарна, төлбөрт

Дутагдал: Unicode дэмждэггүй
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Асуулт ¿ Хариулт ‽

Хэлэл�цүүлэг
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Төгсгөл

b

Анхаарал хандуулсанд баярлалаа!
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